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Foreword

This instruction manual is designed to help you gain a thorough understanding of the operation of
the equipment. Teledyne Isco recommends that you read this manual completely before placing the
equipment in service.

Although Teledyne Isco designs reliability into all equipment, there is always the possibility of a
malfunction. This manual may help in diagnosing and repairing the malfunction.

If a problem persists, call or e-mail Teledyne Isco technical support for assistance. Simple
difficulties can often be diagnosed over the phone. For faster service, please have your serial
number ready.

If it is necessary to return the equipment to the factory for service, please follow the shipping
instructions provided by technical support, including the use of the Return Material
Authorization (RMA) specified. Be sure to include a note describing the malfunction. This will
aid in the prompt repair and return of the equipment.

Teledyne Isco welcomes suggestions that would improve the information presented in this manual
or enhance the operation of the equipment itself.

Teledyne Isco is continually improving its products and reserves the right to change product
specifications, replacement parts, schematics, and instructions without notice.

Contact Information

Customer Service

Phone: (800) 228-4373 (USA, Canada, Mexico)

(402) 464-0231 (Outside North America)

Fax: (402) 465-3022

Email: IscoCSR@teledyne.com

Technical Support

Phone:                Toll Free (800) 775-2965 (Syringe Pumps and Liquid Chromatography)

Email: IscoService@teledyne.com

Return equipment to: 4700 Superior Street, Lincoln, NE 68504-1398

Other Correspondence

Mail to: P.O. Box 82531, Lincoln, NE 68501-2531

Email: IscoInfo@teledyne.com
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General Warnings Before installing, operating, or maintaining this equipment, it is
imperative that all hazards and preventive measures are fully
understood. While specific hazards may vary according to
location and application, take heed of the following general
warnings:

WARNING
Avoid hazardous practices! If you use this instrument in 
any way not specified in this manual, the protection 
provided by the instrument may be impaired.

AVERTISSEMENT
Éviter les usages périlleux! Si vous utilisez cet instrument 
d’une manière autre que celles qui sont specifiées dans ce 
manuel, la protection fournie de l’instrument peut être 
affaiblie; cela augmentera votre risque de blessure.

Hazard Severity Levels This manual applies Hazard Severity Levels to the safety alerts,
These three levels are described in the sample alerts below.

CAUTION
Cautions identify a potential hazard, which if not avoided, may
result in minor or moderate injury. This category can also warn
you of unsafe practices, or conditions that may cause property
damage.

WARNING
Warnings identify a potentially hazardous condition, which 
if not avoided, could result in death or serious injury.

DANGER
DANGER – limited to the most extreme situations 
to identify an imminent hazard, which if not 
avoided, will result in death or serious injury.
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Hazard Symbols The equipment and this manual use symbols used to warn of
hazards. The symbols are explained below.

Hazard Symbols

Warnings and Cautions

The exclamation point within the triangle is a warning sign alerting you of 
important instructions in the instrument’s technical reference manual.

The lightning flash and arrowhead within the triangle is a warning sign alert-
ing you of “dangerous voltage” inside the product.

Symboles de sécurité

Ce symbole signale l’existence d’instructions importantes relatives au 
produit dans ce manuel.

Ce symbole signale la présence d’un danger d’électocution.

Warnungen und Vorsichtshinweise

Das Ausrufezeichen in Dreieck ist ein Warnzeichen, das Sie darauf 
aufmerksam macht, daß wichtige Anleitungen zu diesem Handbuch 
gehören.

Der gepfeilte Blitz im Dreieck ist ein Warnzeichen, das Sei vor “gefährlichen 
Spannungen” im Inneren des Produkts warnt.

Advertencias y Precauciones

Esta señal le advierte sobre la importancia de las instrucciones del manual 
que acompañan a este producto.

Esta señal alerta sobre la presencia de alto voltaje en el interior del 
producto.
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accQpulse™ Velocity Profiler

Section 1 Introduction

1.1 Product Description The accQpulse flow measurement system is designed for both
high and low high accuracy flow measurement applications. 

• The deep water sensor can be used in non-full pipes 6 to 
192 inches (152 mm to 4.9 m) in diameter, or open 
channels with flow depths 6 to 192 inches (152 mm to 
4.9 m).

• The shallow water sensor can be used in non-full pipes 3 
to 48 inches (76 mm to 1.2 m) in diameter, or open 
channel with flow depths 3 to 48 inches (76 mm to 1.2 
m).” 

This system is designed to measure real-time flow rates from a
permanent fixed mount. It consists of a sensor, electronics
housing, cables, and software. A Windows® compatible computer
is required for data collection.

1.2 Operation Pulse Doppler velocity profiling technology measures velocity
distribution within the flow.

1.2.1 accQpulse Sensor The sensor is mounted on the invert of a pipe or channel. Three
piezoelectric ceramic devices emit independent short pulses
along narrow acoustic beams pointing in different directions (see
Figure 1-2). Echoes of these pulses are back scattered from
material suspended in the flow. As this material has motion rel-
ative to the transducer, measurement of the returned echo fre-
quency enables the calculation of the flow velocity.

Figure 1-1 accQpulse velocity sensors

Deep water sensor Shallow water sensor
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Each beam measures velocity at multiple points, or “bins”, within
the water column. The measured velocity data within each bin is
very precise — to within 0.01 ft/s.

A vertical ultrasonic depth transducer is located under the top
surface of the sensor for level measurement.

Figure 1-2 Pulse Doppler flow measurements, dimensions, 
and beam angles

For measurement in low-level flow conditions where the water
depth is 10 inches (25.4cm) or less, the sensor may be mounted in
the Flow Conditioning Platform (FCP) to reduce velocity profile
distortion. The FCP may be used in greater depths, if desired.
The FCP is not available for deep water sensor, use debris
fairing. 

A temperature sensor is located on the sensor’s face between the
horizontal transducers. It is used to measure the water temper-
ature and to calculate the speed of sound.

Note
Flow Conditioning Platform (FCP) is only for the shallow water
sensor.

10.945
(27.80)

2.270
(5.77)

2

3
1

Velocity Profile #2

Flow Pattern

Velocity Profile #1

Transducer

Velocity Profile #2

Flow Pattern
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12.5° front-back

Beam 2&3 Angles:
12.5° front-back;
20° to either side

Beam 2&3 Angles:
20° to front-back
25° to either side

Deep Water Sensor Shallow Water Sensor

Beam 1 Angle:
20° front-back
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1.2.2 Flow Meter The accQpulse divides the return signal into discrete intervals
that correspond to different positions in the flow. Velocity is cal-
culated from the frequency shift measured in each interval. The
result is a distribution of flow velocities, located at different
depths over the entire cross-section of flow. 

Narrow acoustic beams are utilized to accurately determine the
horizontal velocity at each of the depth cell positions. This results
in a precise measurement of the vertical and transverse distri-
bution of flow velocities.

The velocity data is entered into an algorithm to determine a
mathematical description of the flow velocities throughout the
entire cross-section of the flow. The algorithm fits the base func-
tions of a parametric model to the actual data, automatically
adapting to changing hydraulic conditions within the pipe. The
result predicts flow velocities at all points throughout the flow.
These results are integrated over the cross-sectional area to
determine the discharge.

The accQpulse electronic housing protects the electronics and is
intended for indoor or outdoor use to provide protection against
the entry of water during use (submersion protection 2 meters
depth for or 24 hours: IP68). 

The upper portion of the assembly contains all signal processing
boards and solid-state memory for stand-alone operation.

The lower portion of the assembly holds three 6 VDC lantern bat-
teries for the supply of internal power for stand-alone battery
operation. External power in the range of 12-24 VDC can also be
used.

1.2.3 LED The housing contains an LED indicator that shows the opera-
tional status of the accQpulse. Different combinations of color
and state indicate the data quality, deployment status, and con-
nector port status. Table 1-1 lists the possible status conditions
indicated by the various states and colors of the LED indicator.

LED

Table 1-1 LED Indicator Guide

LED Indicator accQpulse Status

State —

Steady light Deployed and taking a reading (but not taking 
depth/velocity profile measurements)

Not deployed but awake.

Flashing, 1 - 2 
second interval

Deployed and taking depth and/or velocity profile 
measurements

Flashing, 30 
second interval 
(adjustable)

Deployed and sleeping between readings.

Not deployed and sleeping.

Interval controlled by CA command. Default: 30 sec.
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Note
If awake and not deployed, the accQpulse will automatically
deploy itself under certain conditions without being pro-
grammed by the user and data collection will occur using what-
ever parameters are stored in the accQpulse at that time.

1.2.4 Optional Secondary 
Depth Sensor

The accQpulse flow meter has a secondary input for level
sensing. Optionally, a secondary depth sensor may be used for
the measurement of surcharge, or as a backup device for the
ultrasonic depth measurement.

The accQpulse accepts a 4-20 mA or 0.4 - 2.0 VDC output from a
secondary depth sensor, which can be a pressure sensor or other
device.

Teledyne Isco offers an optional secondary depth sensor utilizing
a pressure transducer to measure water level (see Appendix A).

Note
To provide proper operation of the flow monitoring system dur-
ing surcharge conditions, please select a secondary device
with a maximum range that exceeds the maximum expected

Off No power to accQpulse.

LED disabled while sleeping.

Fault condition.

Color —

Green All cables and/or dummy plugs properly wired and 
connected.

If deployed taking readings, the data quality is good.

Yellow Deployed taking readings. All cables/dummy plugs 
properly wired and connected. Data is of reduced 
quality (less than 70% good depth readings, one or 
more velocity bins marked bad, or reduced flow 
calculation reliability).

Red Sensor not connected.

Cable or dummy plug not properly wired.

Cable or dummy plug not properly connected

If deployed taking readings, no other faults present, data 
is of poor quality (less than 50% good depth readings, 
three or more velocity bins marked bad, or the flow 
calculation results are unreliable).

Blue Not deployed. Sleeping.

Table 1-1 LED Indicator Guide (Continued)

LED Indicator accQpulse Status
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surcharge level at the flow measurement location. Flow calcu-
lation can be compromised if the max level is exceeded. 

1.3 Technical 
Specifications

The technical specifications for the accQPulse flow monitoring
system are given below in Table 1-2.

Teledyne Isco reserves the right to change specifications without
notice.

Table 1-2 accQpulse Technical Specifications

Measurement Precision

Bin Velocity

Velocity (maximum):

Shallow Water Sensor

Deep Water Sensor

± 30 ft/s (± 9 m/s) at depths less than 30 in (0.8 m), ±10 ft/s (±3 m/s) in 
depths from 30 in (0.8 m) to 48 in (1.2 m)

± 20 ft/s (± 6 m/s) at depths less than 30 in (0.8 m), ±7 ft/s (±2.1 m/s) in 
depths from 30 in (0.8 m) to 33 ft (10 m)

Bin Size:

Shallow Water Sensor

Deep Water Sensor

0.4 in (10 mm)

1 to 4 inches (25 to 100 mm)

Geometry:

Shallow Water Sensor

Deep Water Sensor

#1 12.5° front-back, #2 and #3 12.5° front-back, 20° either side

#1 20° forward, #2 and #3 20° back and 25° either side

Vertical Profiling Range Shallow Water 
Sensor:

Vertical Profiling Range Deep Water 
Sensor:

3 in to 48 in (76 mm to 1.2 m)

6 inches to 16 feet (152 mm to 4.9 m)

Accuracy: 2.0% of reading (Typical in normal flow conditions)

Water Level 

Measurement Range:

Shallow Water Sensor

Deep Water Sensor

3 in to 48 in (76 mm to 1.2 m)

3 in to 32 ft (76 mm to 9.8 m)

Accuracy: ±1% of range (actual measurement)

or ±3 mm (whichever is greater)

Physical

Electronics Unit

Dimensions (HxWxD) 15.6 x 9.4 x 5.9 in. (397 x 240 x 150 mm)

Weight: without batteries 10 lb (4.7 kg) with batteries 16.4 lb (7.4 kg)

Operating Temperature: 23 °F to 104 °F (-5 °C to 40 °C)

Storage Temperature: -13°F to 140 °F (-25 °C to 60 °C)
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Housing: IP 68 compliant

Sensor Signal Cable

Jacket Material: Polyurethane jacket 

Length: 49 ft (15 m) or 147 ft length (45 m) 

Minimum Bend Radius: 6 in (150 mm)

Outer Diameter: 0.5 in (13 mm) nominal

accQpulse Sensors

Operating Temperature:

Shallow Water Sensor

Deep Water Sensor

23 to 104 ºF (-5 to 40 ºC)

23 to 113 ºF (-5 to 45 ºC)

Body Material: Polyurethane 

Static Pressure: 250 psi nominal

Dimensions:

Shallow Water Sensor

Deep Water Sensor

10.5 x 2.3 x 0.6 in (267 x 57 x 16 mm)

8 x 3.6 x 1.5 in (203 x 91 x 38 mm)

Weight:

Shallow Water Sensor

Deep Water Sensor

0.4 lbs (0.2 kg)

1.3 lb (0.6 kg)

Standard Acoustic Frequency: Horizontal transducers 2.4 MHz
Vertical beam 600 kHz

Beam Angles:

Shallow Water Sensor

Deep Water Sensor

#1 12.5° front-back, #2 and #3 12.5° front-back, 20° either side

#1 20° forward, #2 and #3 20° back and 25° either side

Data Management

Data Output

Q, V, D: Flow, Average Velocity, Depth

Velocity: Velocity profile data (relative to acoustic beam directions) per beam and bin

Amplitude: Echo intensity data (relative backscatter intensity) per beam and bin

Data Quality: Profile data quality indicators per beam and bin

Temperature: Transducer temperature output,
range = 20  T  125° F (-7  T  52° C)

Data Storage and I/O

Data Storage Capacity (optional): 4MB standard (15,360 measurements with a typical configuration), slate or 
wrap. 

Data I/O Interface: RS-232 standard. Multiple industry-standard protocols optional.

Serial Baud Rates: 300 to 115,200 bps

Power

Internal Battery Voltage: 18 VDC nominal

Table 1-2 accQpulse Technical Specifications (Continued)
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1.4 Unpacking Inventory When you unpack your accQpulse flow monitoring system, you
should have the following items:

• accQpulse Sensor assembly

• Electronics housing assembly

• Serial communication cable

• External power cable

• WinADFM software CD (Flowlink® software optional)

• Suspension cable kit

• accQpulse Instruction Manual

• Shipping boxes (please save all packing materials)

1.4.1 Optional Equipment Your system may also include the following equipment:

• Secondary depth sensor assembly

• Flow conditioning platform or debris fairing for deep 
water sensor

• Sensor mounting ring(s)

• accQcomm Digital Interface Module (one, two, three, or 
four 4-20mA outputs)

• QBADFM Intrinsic Safety barrier

1.5 Care of the accQpulse 
System

The following section lists guidelines you should be aware of
every time you handle or use the system. Please refer to this list
regularly.

Internal Battery Capacity: 26 Ah at 75° F (24° C) - Alkaline. Battery life 30
weeks at 15 minute sampling interval

External DC: 12 to 24 VDC. 10 VDC absolute minimum. 28 VDC absolute maximum.
12 to 18 VDC with QBADFM Intrinsic Safety Barrier.

Maximum Current: 1.5A

Software

Flowlink® or WinADFM Software for setup, operation, data review, and data management.

QBADFM Intrinsic Safety Barrier and Hazardous Location Sensorsa

Classification: Barrier: Class I, Division 1, groups C and D
Sensors: Temperature class T3

Housing: Polycarbonate

Dimensions (H x W x D)) 12.7" x 9.4" x 3.5" (32.2cm x 23.8cm x 8.8cm)

Weight: 4 lbs 9.4 oz.

Operating and Storage Temperature: -65 to 160° F (-54 to 71° C)

Humidity: 90% to none

a. Refer to Section 3 for complete information about Intrinsic Safety installations.

Table 1-2 accQpulse Technical Specifications (Continued)
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1.5.1 General Handling • Never set the accQpulse sensor facedown on a hard or 
rough surface. This could damage the transducers 
or body.

• Do not store the accQpulse sensor in temperatures over 
167 °F (75 °C). This could damage the transducers.

• Do not lift or support the accQpulse by its cables. This 
puts undue strain on connectors and cables and 
could damage them.

1.5.2 Assembly Guidelines • Do not open the electronics bay (the round, upper area of 
the electronics housing) of the flow meter, or disas-
semble the electronics into the bay. There are no user 
replaceable parts inside the electronics bay.

• Use care when replacing the battery cover after 
replacing the internal 6-volt alkaline lantern batteries. 
Loose, missing, stripped hardware, or a damaged 
battery cover O-ring can lead to internal 
corrosion damage.

• Ensure that all flow meter connectors have either the 
correct cable or a dummy plug connected. The 
accQpulse will not function unless all connectors 
are protected.

• Use care when connecting or disconnecting the cables to 
the flow meter, to avoid damage to the connector 
hardware. The intrusion of water or foreign matter 
in the connector contact area may result in 
permanent damage to the connector and may 
render the accQpulse inoperable.

• If the flow meter is mounted in a high-moisture 
environment, added protection of the connector pins 
may be needed to prevent the intrusion of moisture or 
gas (such as silicone grease).
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1.5.3 Visual Inspection of 
the accQpulse sensor

After each use and before each deployment of the accQpulse,
compare the equipment against the criteria listed in Table 1-3. If
any damage has occurred, contact the factory.

Figure 1-3 accQpulse sensor inspection

Table 1-3 Visual Inspection Criteria

accQpulse Sensor Check the circular faces on the sensor: Rexolite (clear polystyrene plastic) 
on the SW sensor and red urethane on the DW sensor.

There should be no gouges, dents, scrapes, or peeling.

Flow Meter Housing Check the I/O connector for cracks or bent pins.

(Refer to Figures 1-4 and 1-5.)

Cables Check the cable connectors for cracks or bent pins.

Closely inspect the 
transducer faces for 
damage.

Deep Water Sensor
Shallow Water Sensor
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1.6 Connectors Figures 1-4 and 1-5 identify the connectors on the accQpulse
electronic housing.

Figure 1-4 accQpulse connections, left side

Figure 1-5 accQpulse connections, right side

accQpulse
Sensor

Optional
Secondary 

Level Sensor

RS232
Communication

Cable

Optional
External

DC Power
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1.6.1 Cables and Dummy 
Plugs

To attach cables to the flow meter, remove the dummy plug from
the receptacle on the electronics housing. Push the cable con-
nector into the receptacle, with the keyed portions properly
aligned. Screw the coupling ring onto the receptacle finger-tight.
Save the dummy plugs for future use.

CAUTION
All connectors on the flow meter housing must have either the
appropriate cable or a dummy plug connected at all times. The
accQpulse will not function unless all connectors are pro-
tected. A green flashing LED indicates that the accQpulse is
functioning properly.

1.7 Power Requirements The accQpulse is designed to operate on 12 to 24 VDC from three
6 VDC internal lantern batteries, or an external DC power
supply. Both power sources may be used together, but the source
supplying the highest voltage will automatically be the source
that powers the system.

The use of two power supplies together, with the external one
having the higher voltage, can provide uninterrupted operation
of the system during brief power outages.
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accQpulse® Velocity Profiler

Section 2 Installation / Operation

Use this guide to plan your installation layout. Teledyne Isco rec-
ommends distributing this information to your organization’s
planners and installation engineers.

2.1 Software For accurate flow measurement, you will use either Flowlink®
software (optional) or WinADFM software to program the accQ-
pulse with site-specific parameters for the pipe or channel in
which it is installed.

While both software programs are capable of basic site setup and
data retrieval, Flowlink software has expanded capabilities and
features. Contact the factory for more information.

If you have purchased Flowlink software, refer to Section 2.2 for
basic setup and Section 2.7.1 for basic data retrieval and
viewing.

If you are using WinADFM software, refer to Section 2.3 for
basic setup and Section 2.7.2 for basic data retrieval and
viewing.

2.1.1 Channel Geometry The channel shape must be symmetrical about the vertical
center line. It may be possible to use the accQpulse in channels of
other geometries. For further information, contact Teledyne Isco
with specific details of your application.

Prior to installation, the following parameters need to be
recorded, as they are needed by the software to properly con-
figure the accQpulse to accurately calculate discharge. The
software is a self-extracting program. Select the setup file, and
the software will automatically self-install.

Cross-sectional geometry: For rectangular and trapezoidal
channels, record the width (W) and the height (H). For symmet-
rical geometries of irregular shape, record width (W) at 10 dif-
ferent heights. For circular pipes, only the Diameter (D) is
recorded.

Note
Win ADFM must be used for irregular shape. 

2.2 Flowlink Software For complete information about setup and operation of Flowlink
software, refer to the Flowlink user manual and Help files.

2.2.1 Setup 1. Connect the computer to the accQpulse flow meter with the 
communication interface cable.
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2. Click the Quick Connect button on the Flowlink toolbar, or 
press F11 on the keyboard. Flowlink opens the Quick Con-
nect window.

3. Select the Type of connection (Direct for initial setup).

4. Check the Create new site check box and then click on the 
large button for pulse doppler instruments.

5. The Pulse Doppler Connect window will appear.

6. Enter a site name and a device name, and select the radio 
button for accQpulse.
Click OK, and Flowlink creates a site window (Figure 2-1).

Site Info The Site Info tab allows you to view and change the site name
and date/time. Click the Connect button, and Flowlink starts
communication with the accQpulse.

Figure 2-1 Flowlink Site Info tab
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Devices The Devices tab displays general information about the
instrument, secondary depth sensor, and battery (if applicable),
as well as connection information (which can be modified when
offline).

Figure 2-2 Flowlink Devices tab
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Measurements The Measurements tab displays test data in the Output window.

While connected, Flowlink continually polls the site for real-time
readings.

To view real-time data, click the Quick Data button.

Figure 2-3 Flowlink Measurements tab

Click Quick Data to
view real-time data.
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Flow Rate Use the Flow Rate tab to specify the appropriate channel
geometry (as previously described in Section 2.1.1), dimensions,
and sensor mounting information.

Figure 2-4 Flowlink Flow Rate tab: Circular channel
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Flow rate tab: Multi-point 
channels

For multi-point (irregular) channel shapes, measure and record
the channel width divided by 2 for 10 different depths:
Width/2 = X
Depth = Y

Figure 2-5 Flowlink Flow Rate tab: Multi-point channels
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Data View and manage data storage from the Data tab.

Figure 2-6 Flowlink Data tab
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Data tab: Burst sampling Burst sampling is a secondary data reading interval automati-
cally triggered by a programmed threshold condition, such as a
rain event or increased flow.

Figure 2-7 Flowlink: Burst sampling

Note
For complete information on programming and data retrieval,
refer to the Flowlink software manual and Help files.
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2.3 WinADFM Software For complete information about setup and operation of
WinADFM software, refer to the WinADFM user manual.

2.3.1 Setup The following section contains the basic steps for setting up a site
file and programming the accQpulse. Basic data retrieval steps
can be found in Section 2.7. For complete programming and data
retrieval instructions, see the WinADFM software manual.

To begin setup and programming:

1. Start the WinADFM software. Create a Station file (appli-
cation programming file) by selecting File > New. Select 
accQmin Station (Figure 2-8).

Figure 2-8 Creating a new Station file

2. Enter a Site ID with a maximum of 8 alphanumeric char-
acters, with no spaces or symbols, and save.

3. Select ADFM > Setup.
There are four tabs at the top of the window. Select each
tab and enter the programming information in each tab
window. 
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Site tab 4. Site Tab (Figure 2-9) 
Enter comments if desired. Select the units of measure 
from the dropdown list.

Figure 2-9 Site Tab window
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Channel tab 5. Channel Tab
Select the application geometry and enter the appropriate 
dimensions. For more on channel geometry, see Section 
2.1.1.

a. Bed Level is the level of permanent silt/debris in the 
bottom of the channel.

b. Zero Offset is the distance from the bottom of the accQ-
pulse sensor to the bottom of the channel. If you are 
using the Flow Conditioning Platform (FCP), this value 
is typically 0.24 inches (6.1 mm). FCP height will not 
be viable for use with deep water sensor. 

c. FCP Height is the height or thickness of the Flow Con-
ditioning Platform. It is typically 0.88 inches (22.5 
mm). 

If the channel type is not irregular, skip to step 9.

Figure 2-10 Channel Tab window
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Irregular channels 
(multi-point)

6. Irregular Channel Type
For irregular shapes, select Irregular > Configure Points 
(Figures 2-11 and 2-12).

Figure 2-11 Irregular Channel Type window
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Figure 2-12 Irregular Channel Configure window

7. Enter the Width/2 (half the width) and its corresponding 
Height for ten different points (Heights) in the channel. 
Point 1 represents the lowest point in the channel. As you 
enter the widths/2 and their corresponding heights, click 
Update Display to see them represented graphically (Fig-
ure 2-12).

8. When you are finished entering the points, the picture 
should be an approximate representation of the channel’s 
geometry. Make any necessary corrections and click OK.
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Communication tab 9. Communication Tab (Figure 2-13) 
Unless there is an external modem and phone line used, 
select Serial, the communication port of the laptop or com-
puter used to program the accQpulse, baud rate of 115200, 
Stop Bits 1, Data Bits 8, and Parity None.

Figure 2-13 Communication tab
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Profiling tab 10. Profiling Tab (Figure 2-14)
Select the Data Interval (recording interval) in minutes 
from the dropdown list.

11. Select the Samples per Interval (measurement interval).
From the drop-down list, select the desired number of mea-
surements per Data Interval. A larger number will reduce 
battery life but improve measurement precision. Teledyne 
Isco recommends using no more than 5 Samples per Inter-
val in most applications.

Burst sampling 12. Burst Sampling
Burst sampling (reading interval) is a secondary data 
interval automatically triggered by a programmed thresh-
old condition, such as a rain event or overflow.

Figure 2-14 Profiling tab

13. To enable Burst Sampling, check the box next to Burst 
Sampling (Figure 2-14), then select Configure.

a. In the Configure window that appears, select the data 
interval in minutes, and the number of samples (read-
ings) to be taken when the specified trigger conditions 
are met.
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b. In the Enter Level fields, enter the value of Flow (Q), 
Velocity (V), and Depth (D) that will trigger the Burst 
Sampling rate.

c. Enter the Exit Levels in the exit fields. When Q,V, or D 
drops below its Exit value, the accQpulse will switch 
back to the normal operating sample interval, conserv-
ing battery power and data storage space.

14. Under Included Data Types, select all boxes. Select the 
appropriate output (Serial, unless a modem is used).

Data Recording 15. To activate recording and storage of flow information, 
check the Record Internally box, and select Slate or Wrap 
mode.
In Slate mode, the recorder will stop recording when full.
In Wrap mode, the recorder will continue recording when 
full, overwriting the oldest data readings with the newest.

16. If using the Record Internally function, select the maxi-
mum number of intervals from the dropdown list. If the 
accQpulse serial data is output to an Isco 4-20 mA Analog 
Module, select the same number, or 1 less, than the Data 
Interval.

17. Under Data Format, select Reduced.

18. The reading interval for Record Raw Data (Figure 2-14, 
below Data Format) is based on the sampling (reading) 
interval. Recording raw data for a single reading includes 
additional diagnostic information embedded within the Q, 
V, and D reading. The additional raw data creates a larger 
file.
The recommended raw data interval is 10 minutes, i.e., if 
the sample interval = 1, the raw data interval would be 
every 10 readings; if the sample interval = 10, the raw data 
interval would be every 1 reading, etc.

19. Click OK to save the programming information.

2.3.2 Connecting to the 
accQpulse

To begin operating the accQpulse through direct-connection:

1. Connect the computer to the accQpulse flow meter with the 
communication interface cable.

2. Start WinADFM software.

3. Select ADFM > Operate.
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Figure 2-15 Connect screen

4. When the Connect screen appears, select Connect.

Figure 2-16 Connected screen
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5. When the Connected screen appears, select Program > Go.
This programs the accQpulse with the information and 
operational parameters you saved in the Station file, and 
activates flow monitoring operation

Note
If error messages appear when you select Quick Data or Pro-
gram and Go, typical causes are a disconnected sensor cable
and/or invalid station file settings. Ensure that the sensor is
properly connected and that Channel Properties, as well as all
other station file settings, are valid, and retry.

Figure 2-17 Real-time Data screen

6. When the Real-time Data screen appears (Figure 2-17), 
click Exit. Disconnect the interface cable and exit the Oper-
ate screen. Exit the WinADFM software program.

For an overview of data retrieval, turn to Section 2.7.

Note
For complete information on programming and data retrieval,
refer to the WinADFM software manual.
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2.4 Installing the Sensor Sensor installation is discussed in detail in the Isco Mounting
Rings Installation and Operation Guide. The guide explains how
to mount the sensor in flow streams using spring rings, scissors
rings, and mounting plates, as well as use of the flow condi-
tioning platform (FCP).

For accurate measurement, the sensor must be mounted in the
invert (bottom) center of the pipe channel. The top of the sensor
must be level, with the point of the sensor facing upstream, into
the flow (see Figure 2-18). If the Flow Conditioning Platform is
used, center the platform in the invert of the pipe. Use FCP for
current sensor and debris fairing for deep water. 

The accQpulse sensor assembly has four mounting holes. To
avoid damage to the sensor assembly, you should use only these
holes for mounting the sensor to the Flow Conditioning Platform
(FCP).

For pipes and round-bottomed flow streams up to 15" (38.1 cm) in
diameter, stainless steel self-expanding mounting rings
(Spring Rings) are available. For pipes larger than 15" in
diameter, Teledyne Isco offers the Scissors Rings (Universal
Mounting Rings).

Figure 2-18 accQpulse sensor orientation

2.5 Mounting Rings Consult your Isco Mounting Rings Installation and Oper-
ation Guide for detailed hardware information.

The following sections describe sensor installation using the two
options available for mounting the AV sensor in pipes or
round-bottomed flow streams. For pipes up to 15" (38 cm) in
diameter, stainless steel self-expanding mounting rings
(Spring Rings) are available. For pipes larger than 15" in
diameter, Teledyne Isco offers the Scissors Rings (Universal
Mounting Rings).

Flow

Flow
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2.5.1 Spring Rings To install a spring ring, compress the ring, slip it inside the pipe,
and then allow it to spring out to contact the inside diameter of
the pipe. The inherent outward spring force of the ring firmly
secures it in place. A typical self-expanding mounting ring (with
a probe mounted on it) is shown in Figure 2-19.

These mounting rings are available for use in pipes with inside
diameters of 15.2 cm (6"), 20.3 cm (8"), 25.4 cm (10"), 30.5 cm
(12"), and 38.1 cm (15"). The Isco part numbers for the various
size mounting rings available are listed in Appendix B. These
part numbers include not only the ring, but also the miscella-
neous hardware necessary to mount the sensor on the ring.

CAUTION
Always wear leather gloves when handling the rings (either
type). The metal is finished, but there is still a possibility of cut-
ting your hands on the edges.

Figure 2-19 Sensor Installed on a Spring Ring

To complete the sensor-spring ring assembly procedure, attach
the sensor cable to the downstream edge of the ring. Follow the
cable routing shown in Figure 2-19. Other routing directions may
affect measurement accuracy. The cable can actually create a
stilling well downstream from the sensor, causing the level to
read low. Use the self-locking plastic ties supplied with the ring.
Install the ring in the pipe by compressing it. Press inward on
both sides and slide the ring into the pipe. 

Route the sensor cable out of the stream and secure it in position
by placing the ties through the holes in the mounting ring and
then locking them around the cable, as shown in figure 2-19.

...outward force of ring against pipe wall holds
ring in place inside pipe.

Compress ring into gap to install in pipe, then...
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The spring ring may need anchoring. Under conditions of high
velocity (greater than 1.5 meters per second or 5 feet per second),
the ring may not have sufficient outward spring force to
maintain a tight fit inside the pipe. The ring may start to lift off
the bottom of the pipe, or may even be carried downstream.

This problem is more prevalent in the larger diameter pipes and
in pipes with smooth inside surfaces, such as plastic pipes. If any
of these conditions are present, or if movement of the mounting
ring is detected or suspected, you must anchor the ring in place.
You can do this by setting screws through the ring into the pipe,
or by other appropriate means. If there is a problem with the
smaller diameter rings, it may be sufficient to simply increase
the outward spring force of the ring by bending it into a less
round configuration.

2.5.2 Scissors Mounting 
Ring

For pipes larger than 15" in diameter, Teledyne Isco offers the
adjustable Scissors Ring (also known as the Universal Mounting
Ring). This device consists of two or more metal strips that lock
together with tabs to form a single assembly. There is a base
section where the sensors are mounted, two or more extension
sections (usually), and a scissors section at the top that expands
the entire assembly and tightens it inside the pipe. The scissors
section contains a long bolt that increases the length of the
section as it is tightened.

The assembled scissors rings fit pipe diameters from 16" to 80".
Secure the unit in place by tightening the scissors mechanism
with a 5/8" socket wrench or other suitable tool. Ring sections are
.040" thick half-hard 301 stainless steel sheet. All other parts are
also stainless steel, except for the plastic cable ties in the
hardware kit.

Each extension, 1, 2, 3, and 4, adds 9.0", 21.5", 31.5", or 41.5",
respectively, to the circumference of the ring. Used alone, the
base section fits a pipe that is approximately 16" to 19" in
diameter. The 9.0" (smallest) extensions can be used to take up or
remove slack, to bring the scissors mechanism into a position
where it can be effectively tightened.

Note
The hardware kit includes flat head bolts and nuts.Teledyne
Isco strongly recommends bolting the assembled scissors ring
together before installation, using the holes provided for that
purpose. Bolting the tongue sections together can greatly
increase safety and prevent the assembly from being torn
apart.

Do not overtighten the mechanism. It is designed to flex
somewhat to provide a positive lock, once moderately tightened.

For installations in larger channels and/or high flow, extensions
2, 3, and 4 have slots for attaching the ring to the channel wall
using appropriate anchoring hardware.
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Figure 2-20 Scissors Ring adjustment

To prevent debris from catching on the probe cable, it is
important to attach the cable to the mounting ring so it offers as
little resistance to the flow as possible. Attach the sensor cable to
the downstream edge of the ring, using the self-locking plastic
ties supplied with the ring. Place the ties through the holes in the
mounting ring and then lock them around the cable.

CAUTION
Do not overtighten the plastic cable ties; they should be tight-
ened just enough to secure the cable in place, without greatly
indenting the cable. Overtightening the plastic ties may col-
lapse the reference tube in the cable, blocking it.

2.5.3 Mounting the Shallow 
Water Sensor

accQpulse shallow water sensor mounting consists of the fol-
lowing steps:

1. Place the sensor in the cutout from the underside of the 
FCP. The top of the sensor (transducer side up) should be 
flush with the top of the FCP. Insert the 4 sensor mounting 
screws and tighten.

Scissors Assembly

Extensions

Base Section Tightening the scissors assembly expands the ring to 
press firmly against the pipe wall, securing the ring.
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Figure 2-21 Deep water debris fairing and spacers

Figure 2-22 Ring assembly with deep water sensor

Figure 2-23 Shallow water sensor installation with FCP 
and scissors ring

2. Position the bottom of the FCP in the center of the sensor 
mounting ring, with the ring in the FCP indentation. Align 
the 4 mounting holes in the bottom of the FCP with 4 of the 
holes in the ring. Insert 4 screws through the ring into the 
FCP mounting holes and tighten.

Flow
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WARNING
Use gloves and eye protection when assembling and 
installing the sensor in a pipe. Though deburred, the edges 
of the stainless steel can cut if improperly handled.

3. Guide the sensor cable into the cable slot on the underside 
of the FCP and position the cable along the edge of the FCP 
up to the ring and insert cable ties (zip ties) through the 
holes on the downstream edge of the ring to secure the 
cable along the ring to the side or top of the pipe. Cut off 
excess tie straps.

4. Slide the mounting ring into the pipe and align the 
ring/sensor in the pipe. The sensor/FCP should be centered 
in the invert of the pipe, with the pointed end of the sensor 
facing upstream. The top of the sensor/FCP should be level. 
Secure the ring and sensor cable in the pipe.

a. To install the mounting ring, compress the ring, slip it 
inside the pipe, and then allow it to spring out to con-
tact the inside diameter of the pipe. The inherent out-
ward spring force of the ring firmly secures it in place.

5. In a non-corrosive atmosphere, connect all required cables 
to the flow meter electronics housing.

2.5.4 Mounting the Deep 
Water Sensor

accQpulse deep water sensor installation consists of the 
following:

Place the sensor in the straightest possible run, at a minimum of
5 channel diameters downstream from a bend and 2 channel
diameters upstream from a bend. The sensor should be securely
positioned, with minimal potential for fouling or damage from
sediment or debris. In installations where high velocity/debris
will be present, you may consider protecting the entire cable
length (i.e., with user-supplied rigid conduit or metal framing).

Note
In all installations, the sensor mounting must be firmly
anchored flat against the invert (center) of the channel (zero
pitch, zero roll).

Note
When using deep water fairing spacers, a maximum number of
2 spacers should be used. 
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Figure 2-24 Mount the sensor flat on the channel floor

Note
If debris and/or silt are expected, the sensor must be elevated
with the proper fairing/spacer combination to ensure proper
operation, as described on the last page.

Sites where a large amount of aeration or turbulence will be
present often require the use of a secondary pressure transducer.
In these cases, the mounting of the secondary sensor, including
elevation and orientation, must also be considered.

The long side of the sensor must be parallel with the longitudinal
axis of the channel.

Figure 2-25 Sensor alignment along channel wall

No

No

Yes

Flow Flow 

No Yes
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Cabling Be careful to route the cable away from the side of the sensor
where it is attached. Improper cable routing increases the possi-
bility of debris fouling.

Figure 2-26 Sensor cable direction

During installation, ensure that the cable connector end is sealed
for protection in case it comes into contact with water.

If a mounting apparatus (such as a ring or rectangular frame) is
used, cables should be fastened to its downstream side. All per-
manent installations require the cables to be secured to the
channel wall and mounting apparatus with rubber-cushioned
stainless steel loop straps at 6" (nominal) intervals.

Figure 2-27 Securing the cable(s) with SST straps

User-supplied cable conduit must have a minimum inner
diameter of 2 inches (to accommodate the cable connector). If
routing requires bending the cable, it must have a minimum
bend radius of 6 inches. The sensor cable should not be spliced,
and should remain intact from the sensor to the control box.

Flow Flow

No Yes

CABLE(S)

Flathead
screw

Flat washer

Lock nut

Isco mounting
ring
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Note
Always secure the sensor cable to the mounting apparatus and
channel wall. Permanent installations require the use of
bolted stainless steel straps. Plastic cable ties alone are not
recommended for any installation, but if used, should have
minimum 50 lb loop strength.

Circular Channels For large diameter pipes and manhole inverts, Isco’s adjustable
Scissors Ring (also known as the Universal Mounting Ring) is
available in sets consisting of a base section, a scissors mech-
anism for adjustment, and one or more pairs of extensions to fit
the specific channel size. The base section is equipped with holes
and tabs for mounting other Isco sensors.

Note
Complete information about the Scissors Ring is provided in
the Isco Mounting Rings Installation and Operation Guide
(available at www.isco.com), or call the factory for details about
choosing and installing your configuration.

WARNING
Use gloves and eye protection when assembling and installing 
the Isco Mounting Rings.

Figure 2-28 Scissor ring

Scissors Assembly

Extensions

Base Section Tightening the scissors assembly expands the ring to 
press firmly against the pipe wall, securing the ring.
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Scissors Ring Assembly 1. In order for the deep water sensor (or fairing/spacer) to be 
mounted flush against the bottom of the scissors ring, and 
to avoid accumulation of debris, the six tabs in the center of 
the base section must be flattened. This can be accom-
plished by hammering and bending the tabs.

Figure 2-29 Flatten the six center tabs on the base section 

2. Assemble the Scissors Ring, attach the sensor, and secure 
the cables above ground.

3. Assemble the ring, making sure the tongue sections are 
fully inserted into the slotted sections and over the secur-
ing buttons.

4. Bolt the sections together to increase safety and prevent 
the assembly from being dislodged or separated by the flow 
stream.

Figure 2-30 Assembling the ring and mounting the sensor 
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Figure 2-31 Deep water sensor on assembled scissor ring

5. Lower the assembly into the pipe with the sensor directly 
on the bottom center, parallel with the channel wall, facing 
into the flow. Tighten the scissors assembly to expand the 
ring outward so that it is pressed entirely flat against the 
pipe wall.

a. For additional reinforcement, anchor the ring to the 
pipe wall using the slots provided and user-supplied 1/4" 
x 21/4" SST concrete wedge anchors.

b. For manhole invert installations, the scissors mecha-
nism may be omitted. Anchor the base section and any 
extensions to the pipe wall.

Note
Be very careful to position the sensor flat against the channel floor, 
facing into the flow.

6. Secure the cable along the top or side of the pipe to prevent 
damage, dislodging, and collection of debris.

Note
If you intend to exceed 5 inches of total sensor lift, custom
thread rods are required for proper installation. 

2.5.5 Completing the Sensor 
Installation

The sensor installation is finished by securing any excess sensor
cable using cable clamps or other means.

The sensor cable should be handled and mounted with care. Also,
if there is any appreciable distance between the point where the
sensor cable leaves the mounting apparatus and the location of
the flow meter, be sure to attach the cable to the flow stream wall
to prevent it from vibrating, moving around, tangling, or possibly
collecting debris.
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CAUTION
Under no circumstances should you leave any extra length of
sensor cable dangling freely in the flow stream where it could
trap debris or become tangled.
Use gloves and eye protection when assembling and installing
the rings in a pipe. Though deburred, the edges of the stain-
less steel can cut if improperly handled. Please read the infor-
mation in the Isco Mounting Rings Installation and Operation
Guide on how best to install this device.
Observe general safety procedures when entering any man-
hole. See “General Safety Procedures” in the back of this man-
ual for more information on general hazards and necessary
precautions.

2.6 Flow Meter Mounting 
and Installation

The accQpulse flow meter housing must be mounted to a rigid
structure, such as a solid wall or ladder rung.

2.6.1 Wall Mounting For wall mounting, attach the wall mounting plate to the back of
the accQpulse flow meter housing, using 4 supplied bolts. Attach
the wall plate securely to the wall.

2.6.2 Suspension Mounting To suspend the accQpulse flow meter housing, loop the sus-
pension harness (kit #60-7109-002, Figure 2-32) around the
accQpulse’s handle and a ladder rung, or the Isco Spreader Bar.

The Spreader Bar (part #60-3004-110) is an expandable pipe that
serves as an equipment hanger inside a manhole. Outward
spring pressure holds it securely against the walls of the
manhole, like a shower curtain rod. The flow meter is then sus-
pended from the bar.
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Figure 2-32 accQpulse suspension harness

2.6.3 Eyebolt Suspension 
Mounting

For manhole mounting without rungs or spreader bar, use a 5/16"
or 3/8" threaded eyebolt with lag shield (anchor lug), as shown in
Figure 2-33. Drill a hole near the top of the manhole, just below
the cap, and insert the lag shield and eyebolt, as shown in Figure
2-34. Attach the accQpulse to the eyebolt with a wire cable.

Figure 2-33 Eyebolt and lag shield

Eyebolt Lag Shield



accQpulse® Velocity Profiler
Section 2  Installation / Operation

2-32

Figure 2-34 Lag shield - eyebolt manhole mounting

2.6.4 Final Precautions Secure the cables and provide strain relief by inserting
wire/cable ties around the cable and through the holes in the
black fittings directly below each cable connector (Figure 2-35).

Leave slack in the cable between the connector and the black
fitting. Cut off the excess tie straps.

Figure 2-35 Cable tie fittings on flow meter housing
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2.7 Data Retrieval This section offers a brief overview of collecting data from your
accQpulse system with Teledyne Isco’s software programs. For
full details of site setup and data management, refer to the
software instruction manual.

2.7.1 Flowlink To begin downloading data from the accQpulse through direct
connection:

1. Connect the computer to the accQpulse flow meter with the 
communication interface cable.

2. Start Flowlink software.

3. In the workspace on the left, open the desired site file. The 
site window opens.

Figure 2-36 Site Info tab: Connect and Retrieve Data 
buttons

4. On the Site Info tab, click the Connect button.

5. Once the site is online, the Retrieve Data button becomes 
active. Click the Retrieve Data button to download data 
from the site.
A progress bar will indicate the download status.

Note
To retrieve only the data collected since the last interrogation,
press Shift + F8 to open the Retrieve Options window.
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Figure 2-37 Flowlink: Data download

6. Upon completion, Flowlink will prompt whether or not to 
erase the accQpulse data recorder. Clicking Yes will 
increase storage capacity.

Viewing the data In the workspace on the left, expand the site file tree to display
devices in the site and the accQpulse’s measured parameters. To
quickly graph data, double-click on any parameter (Figure 2-38).

Figure 2-38 Flowlink: Graphing data (velocity shown)
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To view multiple parameters on the graph, simply drag and drop
them into the graph.

Figure 2-39 Flowlink: Drag & drop data parameters on graph (velocity and flow shown)

Flowlink’s Pulsed Doppler graphing properties include many
editing and formatting capabilities, and other features such as
Scatter plots, Flow Profile, and data quality indicators of
amplitude and correlation. For detailed information, refer to the
Flowlink user manual and Help files.

Note
Real-time data viewing requires pushed data capability, avail-
able with Flowlink Pro. Contact the factory for more informa-
tion.
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2.7.2 WinADFM To begin downloading data from the accQpulse through
direct-connection:

1. Connect the computer to the accQpulse flow meter with the 
communication interface cable.

2. Start WinADFM software.

3. Select File > Open.

4. Select the appropriate Station file (.stn file).

5. Select ADFM > Operate.

6. Click Connect (Figure 2-40).

Figure 2-40 Connect Screen

7. Select Collect Data.
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Figure 2-41 Collect/Erase Data

The Collect window shows the name of the data file being col-
lected and the number of bytes transferred, as well as the size of
the data file.

Figure 2-42 Collect window

When the download is finished, you can erase the recorder by
clicking Erase Data (Figure 2-41).

8. When finished, select Program & Go to restart the accQ-
pulse. When the Program & Go screen appears, click Exit.

9. Disconnect the communication interface cable from the 
accQpulse, exit the Operate screen, and quit the 
WinADFM software program.

Viewing the Data To view the downloaded data, start WinADFM and open the
desired Station file. Select Display, then Data.
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Figure 2-43 Data window

The data files available for viewing will appear in the Data
window (Figure 2-43). Click the data file to view and select the
viewing mode from the column of buttons on the right. For
example, selecting Expert View would result in a view similar to
Figure 2-44.

Exit WinADFM when finished.

Figure 2-44 Viewing data in Expert View



3-1

accQpulse® Velocity Profiler

Section 3 QBADFM Intrinsic Safety Barrier Module

3.1 Overview The purpose of intrinsic safety is to limit the energy available to
a given circuit or device to a level where electrical discharge
(sparking) or component heating cannot ignite the hazardous
(flammable or explosive) atmosphere. With no spark ignition pos-
sible, safe operation of the equipment in areas with hazardous
atmospheres is possible.

WARNING
Avoid hazardous practices! If you use this instrument in 
any way not specified in this manual, the protection 
provided by the instrument may be impaired; this will 
increase your risk of injury.

AVERTISSEMENT
Évitez les conduites dangereuses ! Si vous utilisez cet 
instrument à des fins autres que celles spécifiées dans le 
présent manuel, la protection intrinsèque risque d'être 
altérée, ce qui augmente les risques de blessure.

The QBADFM Intrinsic Safety Barrier Module is intended as an
interface located in a transition area between the sensor(s) in a
designated explosive gas hazardous area, and the accQpulse elec-
tronics located in a safe area. The transition area is to contain
intrinsically safe wiring that must be separated from high
voltage or other wiring that is not intrinsically safe. See the
control drawing in Figure 3-3 for wiring in designated areas.

User-supplied conduit is normally installed between the haz-
ardous area and transition area for the routing of sensor
extension cables.

The QBADFM is “associated apparatus” approved for
Class I, Division 1, groups C and D. Associated hazardous
location sensors are temperature class T3.
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Figure 3-1 accQpulse IS system components

3.1.1 Class I These are locations where flammable gases or vapors may be
present in the air in quantities sufficient to produce explosive or
ignitable mixtures. Equipment approved for these locations has
been evaluated for maximum explosion pressure, maximum safe
clearance between parts of a clamped joint in an enclosure, and
the minimum ignition temperature of the atmosphere mixture.

3.1.2 Class I, Division 1 These are locations in which:

1. ignitable concentrations of flammable gases or vapors can 
exist under normal operating conditions; or 

2. ignitable concentrations of such gases or vapors may exist 
frequently because of repair, maintenance operations, or 
leakage; or

3. breakdown or faulty operation of equipment or processes 
might release ignitable concentrations of flammable gases 
or vapors, and may also cause simultaneous failure of elec-
tric equipment.

Installation should be completed with adherence to local require-
ments, and should be done by trained and qualified personnel.

WARNING
Explosion hazard. Substitution of components may impair 
intrinsic safety.

AVERTISSEMENT
Risque d’explosion. Le remplacement de composants peut 
réduire la sécurité intrinsèque.

WARNING
Wiring in the hazardous area shall comply with all relevant 
national standards and any standards of local authorities 
having jurisdiction. These may include article 504 of the 
National Electric Code (NEC) or ANSI/ISA RP - 12.6 in the 
United States, and Canadian Standards Association (CSA) 
C22.2 in Canada.

SAFE

Electronics QBADFM Box Sensor(s)

TRANSITION HAZARDOUS
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AVERTISSEMENT
Le câblage réalisé dans la zone dangereuse doit être 
conforme aux normes nationales en vigueur et à toute 
norme édictée par les autorités locales. Ces normes 
peuvent inclure l’article 504 du code électrique national 
(NEC) ou la norme ANSI/ISA RP - 12.6 aux États-Unis, ainsi 
que la norme C22.2 de l’association canadienne de 
normalisation « Canadian Standards Association » (CSA) 
au Canada.

3.2 Description The QBADFM module contains power barriers for each of the
four ultrasonic transducers in the accQpulse IS sensor (3 for
velocity and 1 for level) as well as the temperature sensing cir-
cuitry.

The unit includes a space for a stand-alone MTL700 barrier for
analog input from a secondary level sensor. For field upgrade of a
QBADFM for the pressure option, Teledyne Isco offers two
pressure sensor upgrade kits: the first for users who wish to
provide their own signal barrier and secondary level sensor; the
second including an Isco-provided signal barrier and extension
cable for Isco-provided IS secondary sensor.

Kit#1 Optionally, the QBADFM module may contain a mounting
bracket for a stand-alone signal barrier and accQpulse input
cable for a secondary level sensor with pressure transducer. To
upgrade an existing module with this option, order kit
#60-7407-001.

Kit#2 In addition to the kit above, the QBADFM module may also
contain the Isco-provided stand-alone power barrier, and cabling
for an Isco IS secondary level sensor with pressure transducer
(sensor ordered separately). To upgrade an existing module with
this option, order kit #68-7400-107.

Figure 3-2 Barrier box with (right) and without (left) factory-installed barrier for secondary sensor

3     
4 2 

    
1

Beam 1

Beam 3

Beam 2

Beam 4

Therm/
EEPROM

Beam 1

Beam 3

Beam 2

Beam 4

Therm/
EEPROM

1

2

3

Beam

Beam

Beam

Isco-provided
power barrier

accQpulse
Ext. cable

Q75EXT-CTL

2ndary
Ext. cable

P75EXT-CTL
Cable -> accQpulse 
sensor port

Cable -> accQpulse 
2ndary sensor port

IS Ground /
Earth Bond



accQpulse® Velocity Profiler
Section 3  QBADFM Intrinsic Safety Barrier Module

3-4

3.3 System Connections The unit is shipped with any extension cables factory installed.
Complete system connections are specified in the control drawing
located on the inside of the QBADFM enclosure lid (Figure 3-3).

WARNING
Do not coil the IS SWADFM sensor cable or Q75EXT-CTL 
cable. Maximum safe length is 75 meters combined.

AVERTISSEMENT
N’enroulez pas le câble du capteur I.S. SWADFM ou le câble 
Q75EXT-CTL. La longueur de sécurité maximale est de 
75 mètres.

CAUTION
The weight of the cable(s) should not place strain upon the
connector(s). Side-loading the sensor connectors can compro-
mise the ingress protection seals (see drawing at left).

AVIS
Le poids des câbles ne doit pas appliquer de contrainte sur les
connecteurs. Le chargement latéral des connecteurs du
capteur peut compromettre l'étanchéité (voir dessin à gauche).

3.3.1 Pressure Sensor The optional secondary level sensor from Isco uses a pressure
transducer. This sensor must be installed according to the control
drawing in Figure 3-4.

WARNING
Do not coil the IS pressure sensor cable or P75EXT-CTL 
cable. Maximum safe length is 150 meters combined.

AVERTISSEMENT
N’enroulez pas le câble du capteur I.S. de pression ou le 
câble P75EXT-CTL. La longueur de sécurité maximale est 
de 150 mètres.

3.3.2 User-Supplied Conduit User-supplied, properly sealed conduit with minimum inner
diameter of two inches, is normally installed for routing the
sensor extension cable(s) between the hazardous area and tran-
sition area.

In order to feed the cables through conduit with an inner
diameter that does not accommodate the connectors, the cables
must be disconnected from the QBADFM unit.

YES

NO
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WARNING
To prevent ignition of flammable or combustible 
atmospheres, always disconnect the system from AC 
power before servicing.

AVERTISSEMENT
Afin d’éviter l’embrasement des atmosphères 
combustibles ou inflammables, vous devez toujours 
débrancher le système de l’alimentation secteur avant d’en 
effectuer la maintenance.
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Figure 3-3 Control drawing: IS system connections

L’utilisateur est tenu de raccorder 
l’appareil à une prise de terre.

L’appareil branché ne doit pas 
générer plus de 250 V par rap-
port à la terre dans des condi-
tions normales ou anormales.
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Figure 3-4 Control drawing: Pressure sensor installation
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3.4 Accessing 
Components

Ensure that the system is disconnected from mains power. Open
the top cover by loosening the four screws holding it in place.

Figure 3-5 Accessing the QBADFM’s interior (shown with optional standalone barrier)

3.4.1 accQpulse Sensor 
Extension Cable

The accQpulse sensor extension cable Q75EXT-CTL is built to
the required length which, when combined with that of the
IS-SWADFM sensor cable, must not exceed a maximum length of
75 meters. It is connected through the larger cord-grip fitting on
the right side of the box (see Figure 3-5), and includes wiring for
temperature sensing as well as the four ultrasonic transducers.

While the Q75EXT-CTL cable is normally built to the length
specified in the order, it is possible for the user to cut and strip
the cable to a shorter desired length. If user wiring becomes nec-
essary, follow the procedures described in this section.

CAUTION
Take care not to puncture or tear the desiccant bag while per-
forming wiring procedures inside the unit.

Control drawing
Wiring diagram

Optional Barrier

Temp Sense wiring

Transducer Barrier
shielding

P75EXT-CTL cable
cord-grip fitting

Q75EXT-CTL cable
cord-grip fitting

User-supplied tools & equipment required

• Phillips screwdriver
(top cover & board terminals)

• Small flat screwdriver (barrier terminals)

• Medium flat screwdriver (cable clamp)

• Open wrenches (nylon lock and sealing nuts):

· 15mm, 25mm

· 19mm, 27mm

• Torque device

• Plastic cable tie & sidecutters (if replacing 
desiccant bag)

• Needlenose pliers (wire routing)

• Conduit for sensor extension cables

Desiccant bag

60-7404-975
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AVIS
Veillez à ne pas percer ou déchirer le sachet déshydratant lors
des procédures de câblage à l’intérieur de l’unité.

To access the wiring connections for each transducer, pull the
metal shield straight out from the board (Figure 3-6). The red,
black, and shield wires for temperature sensing are located just
below the secondary barrier slot.

Figure 3-6 Accessing accQpulse thermal and transducer terminal connections

Note that the twisted pair cable feeds under the shield bracket
via a slot in the circuit board (Figure 3-7). Ensure that it is rein-
stalled in the same manner. This is most easily accomplished by
pushing the wires into the slot under the bracket and then
pulling them through to the other side with needlenose pliers.

Figure 3-7 Wire routing and connections

Once all 15 wires have been disconnected from their terminals,
loosen the cable clamp. Unscrew the sealing nut, and pull the
extension cable out through the cord-grip fitting.

Therm/EEPROM
red, shield, & black

Transducer
(Beam 3 shown) violet,

shield, & black

Terminal
connections

Shield
bracket

Wire
slot
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Figure 3-8 Release cable from clamp and cord-grip fitting

3.4.2 Secondary Sensor 
Extension Cable

The optional pressure sensor extension cable P75EXT-CTL is
built to the required length which, when combined with that of
the IS secondary sensor cable, must not exceed a maximum
length of 75 meters. It is connected through the smaller cord-grip
fixture on the right side of the box (see Figure 3-2).

While the P75EXT-CTL cable is normally built to the length
specified in the order, it is possible for the user to cut and strip
the cable to a shorter desired length. If field-installing Kit #2, or
if user wiring becomes otherwise necessary, follow the procedures
described in this section.

Note that for user-supplied cabling, shield grounding is provided
at TB18, next to the barrier slot (see Figure 3-9).

Figure 3-9 Disconnecting the secondary level sensor extension cable

CAUTION
Take care not to puncture or tear the desiccant bag while per-
forming wiring procedures inside the unit.

AVIS
Veillez à ne pas percer ou déchirer le sachet déshydratant lors
des procédures de câblage à l’intérieur de l’unité.

Cable 
clamp

Sealing
nut

60-7404-875

TB18

Stand-Alone Barrier
(factory-installed

barrier shown)

P75EXT-CTL 
extension 
cable
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Note
Always keep the shield drain wire as short as possible for best
performance.

Once the wires have been disconnected from their terminals,
remove the flat washer, unscrew the sealing nut, and pull the
extension cable out through the cord-grip fitting.

3.5 Reassembly When ready to reassemble the barrier, reinsert the sensor
extension cable(s) through their respective cord-grip fittings,
tightening the cable clamp and the flat washer up against the
lock nut inside the case to provide strain relief for the cables.

Figure 3-10 Strain relief for sensor extension cables

Wiring Re-connect each wire to its barrier circuit as before, referring to
the wiring table on the inside of the lid (Figure 3-3), or Table 3-1
on the following page. Replace the barrier shields by pressing
them down into their spring brackets.

Note
Always keep shield drain wires as short as possible for optimal
performance.

Note that the twisted pair cables feed under the shield brackets
via a slot in the circuit board (Figure 3-7). Ensure that they are
reinstalled in the same manner. This is most easily accomplished
by pushing the wires into the slot under the bracket and then
pulling them through to the other side with needlenose pliers.
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Closure

WARNING
Ingress protection is dependant upon proper reassembly. 
To avoid internal damage from moisture contamination:

• Use the wrenches to tighten the cord-grip fittings to 
the following specifications:

• Inspect the lid sealing gasket, ensuring that it is 
undamaged and free of foreign material.

• Close the lid and tighten the four enclosure cover 
screws to 8 inch-lbs.

Snake loop All cables should be secured and kept as short as possible.

WARNING
Do not coil the sensor cables; this will form an inductor and 
create a hazard. If necessary, use a snake loop (see figure 
at left) instead.

Fitting Locking Nut Sealing Nut

Small (P75EXT-CTL) 19mm 14 ±0.5 inch-lbs 15mm 14 ±0.5 inch-lbs

Large (Q75EXT-CTL) 27mm 40 ±0.5 inch-lbs 25mm 50 ±0.5 inch-lbs
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Fermeture

AVERTISSEMENT
L'étanchéité dépend de la qualité du réassemblage. Afin de 
prévenir les dommages internes liés à l'humidité :

• Utilisez les clés pour serrer les raccords serre-câble 
selon les spécifications suivantes:

• Inspectez le joint d’étanchéité du couvercle, en 
vérifiant qu’il n’est pas endommagé et qu’il n’est pas 
en contact avec une substance étrangère.

• Fermez le couvercle et serrez les quatre vis du boîtier à 
0,9 N/m (8 pouces/lbs).

Tous les câbles doivent être fixés et de longueur la plus courte
possible.

Acheminement

AVERTISSEMENT
N'enroulez pas les câbles du capteur, sous peine de former 
un inducteur et d'engendrer un risque de danger. Si 
nécessaire, disposez plutôt le câble en lacet (voir schéma 
à gauche).

Raccord Ecrou de blocage Ecrou étanche
Petit (P75EXT-CTL) 19mm 14 ±0.5 inch-lbs 15mm 14 ±0.5 inch-lbs
Grand (Q75EXT-CTL) 27mm 40 ±0.5 inch-lbs 25mm 50 ±0.5 inch-lbs
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Figure 3-11 Tab locations on QBADFM CBA

Table 3-1 QBADFM 
Wiring Table

Function Color TAB

Beam 4

White TB1

Shield TB2

Black TB3

Therm/
EEPROM

Red TB4

Shield
TB5

Black

Beam 3

Violet TB6

Shield TB7

Black TB8

Beam 2

Green TB9

Shield TB10

Black TB11

Beam 1

Orange TB12

Shield TB13

Black TB14
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3.6 Maintenance The QBADFM box is not field repairable, other than replacement
of the desiccant bag and fuses. For other needs, contact Teledyne
Isco for assistance or return the unit to the factory for service.

3.6.1 Internal Desiccant A desiccant bag is attached to the inside corner of the case to
prevent moisture from accumulating inside the box. The
humidity indicator card should always be blue. If it turns pink or
white, humidity is present inside the box, which can potentially
damage the electronics. Ensure that the QBADFM box is
properly sealed against ingress, as described in Section 3.5.

Humidity inside a properly sealed unit may be caused by spent
desiccant, in which case the bag should be reactivated or
replaced.

Desiccant reactivation To reactivate the desiccant, cut the cable tie and remove the bag
from the QBADFM box. Place the bag(s) on a piece of heavy paper
on a flat metal sheet. (A brown grocery sack and a typical cookie
sheet will suffice.) Do not stack bags on top of each other or allow
them to touch. Place in a vented, circulating forced air, conven-
tional oven in a well ventilated room. Allow two inches of air space
above the tops of the bags.

Keep the tray a minimum of 16 inches from the heating element.
Heat the bags at a temperature of 245°F (119°C) for 16 hours. At
the end of the time period, the bags should be immediately
removed and placed in an air tight container for cooling. After
repeated recharging, the desiccant bag may require replacement.

Figure 3-12 Location of desiccant bag and humidity indicator

CAUTION
Take care not to puncture or tear the desiccant bag while per-
forming wiring procedures inside the unit.

AVIS
Veillez à ne pas percer ou déchirer le sachet déshydratant lors
des procédures de câblage à l’intérieur de l’unité.

099-0002-01

Humidity
indicator card
(490-0013-00)

Desiccant
bag
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3.6.2 Fuses The QBADFM barrier unit contains a total of 10 fuses: 2 for each
of the SWADFM sensor barriers, one for the Therm/EEPROM
barrier, and one spare fuse on the lower left corner of the board.

The fuses are mounted with two spade connectors (see
Figure 3-13 on the following page). To replace the 0.2A, 250V
fast-blow fuse, simply pull it straight out from the board and
push the new fuse into the spade connectors.

Figure 3-13 Locations of QBADFM fuses (10 total)

60-7404-020

Spare 
fuse
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Section 4 Maintenance

4.1 Maintenance 
Overview

This section explains the maintenance requirements of the accQ-
pulse flow monitoring system.

The system is designed to perform reliably in adverse conditions
with a minimal amount of routine service requirements. To keep
your system working properly, the following should be checked at
regular intervals:

• Battery power

• Desiccant and anti-corrosion disk

• Channel conditions

Maintenance intervals are affected by many variables. Humidity
levels obviously affect the service life of the desiccant, and the
amount of debris in the stream can drastically alter the channel
conditions.

Experience is often the best tool to use when establishing
minimum maintenance intervals for your system. Until you have
gained an understanding of the accQpulse’s operation under dif-
fering environmental conditions, a weekly maintenance interval
is recommended.

4.2 Battery Replacement The battery compartment holds three 6-volt alkaline lantern bat-
teries.

DANGER
If the unit is connected to an external power 
supply, disconnect the external power supply 
before opening the battery compartment.
Use care to avoid shorting the battery leads, as 
fire or personal injury can result.
The batteries do not have a fuse.

DANGER
Si l’unité est raccordée à une alimentation 
externe, débranchez celle-ci avant d’ouvrir le 
compartiment à piles. Veillez à ne pas 
court-circuiter les fils des piles, au risque de vous 
blesser ou de provoquer un incendie. Les piles 
ne sont pas protégées par un fusible.

Teledyne Isco
Customer Service Dept.
P.O. Box 82531
Lincoln, NE 68501 USA

Phone: (800) 228-4373
(402) 464-0231

FAX: (402) 465-3022

E-mail:
IscoCSR@teledyne.com
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Figure 4-1 Battery replacement

The accQpulse uses three internal alkaline batteries, Eveready
Energizer, Model 529, with a nominal capacity of 26 Ah each.
The nominal voltage is 18V for all batteries connected in series,
with a minimum voltage of 10V. Teledyne Isco recommends pur-
chasing spare batteries, which are commonly available.

You should only replace the batteries in a non-corrosive envi-
ronment.

CAUTION
The following precautions during battery replacement must be
observed:
• Do not mix old and new batteries.
• Do not use non-alkaline batteries.
• Do not mix batteries of different brands.
• Never use damaged batteries.
• Do not use expired batteries (see battery expiration date)

Do not open

Battery Compartment
Door

2-258 O-Ring

Battery Retaining
Plate

6-Volt Alkaline
Batteries

Electronics
Housing



accQpulse® Velocity Profiler
Section 4  Maintenance

4-3

CAUTION
Never leave the batteries inside the accQpulse for extended
periods of time. The batteries may leak, causing damage to the
electronics. Store them in a cool, dry place (0 to 21° C)

1. Remove the battery compartment door by loosening the 
seven thumbscrews.

Figure 4-2 Battery cover removal

2. Remove the battery retaining plate assembly by turning 
the threaded wheel counterclockwise until it comes loose 
from the center bolt.

Figure 4-3 Loosening the battery retaining plate assembly
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Figure 4-4 Removing the battery retaining plate assembly 
from the center bolt

3. Remove all of the old batteries, and replace with three new, 
Eveready Energizer, Model 529 alkaline lantern batter-
ies, with the terminals facing downward.

4. Replace the desiccant bag (see Section 4.5) and anti-corro-
sion disk (see Section 4.4).

5. Ensure that the battery compartment O-ring is in good 
condition and in its groove (see Section 4.3).

6. Install the battery retaining plate assembly; finger-tighten 
the wheel on the center bolt.

CAUTION
Over-tightening will strip the plate’s plastic threads.

7. Install the battery cover assembly over the battery com-
partment. Finger-tighten the seven thumbscrews in a diag-
onal pattern.

CAUTION
Do not tighten the thumbscrews with a screwdriver or any other
tool. Over-tightening will strip the battery cover threads.

4.3 Battery Cover O-Ring Always inspect the O-ring and O-ring groove (see Figure 4-5),
replacing the O-ring if necessary, before sealing the accQpulse.
The condition of the O-ring and groove are critical to the accQ-
pulse’s functionality. Remove and reinstall the battery com-
partment cover as described in the steps in Section 4.2.

1. The O-ring must be smooth and uniform in appearance, 
free of cuts, indentations, abrasions, foreign matter, and 

Battery Retaining 
Plate

Center Bolt

Desiccant 
Bag
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flow marks. Ensure that the O-ring is not compressed from 
prior use. A weak or damaged O-ring will result in 
water entering the accQpulse.

2. Clean and inspect the O-ring groove. It must be free of for-
eign matter, scratches, indentations, corrosion, and pitting. 
Scratches may be gently sanded with wet, 600-grit sandpa-
per. Use care not to cause further damage.

3. Wearing latex gloves, apply a very thin coat of silicone 
lubricant to the O-ring. Too much lubricant, or loose fibers 
sticking to the O-ring, will cause leakage.

Figure 4-5 Battery compartment cover underside

4.4 Anti-Corrosion Disk The anti-corrosion disk (Figure 4-5, above) protects the battery
housing interior.

Removal and reinstallation of the battery compartment cover are
described in the steps in Section 4.2. To replace the anti-cor-
rosion disk:

Remove the new anti-corrosion disk from the airtight aluminum
bag. The anti-corrosion disk is adhered to the underside of the
battery compartment cover. Remove the old anti-corrosion disk
and install the new one.

4.5 Desiccant Bag The desiccant bag is essential for dehumidifying the battery
housing interior. The factory-supplied desiccant lasts one year
when used at the specified depths and temperatures. 

The chemical in the desiccant bag looks like small beads or
pellets that are blue-black when dry, pale pink to transparent
when saturated. 

O-Ring

Anti-
Corrosion Disk
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Desiccant rapidly absorbs moisture from the ambient air. Des-
iccant bags should be replaced just before deployment, and
whenever you replace the batteries.

CAUTION
Never open a desiccant bag. Contact with the silica gel can
cause nose, throat, and skin irritation.

Note
Desiccant bags are shipped in an airtight aluminum can to
ensure maximum effectiveness. There is a humidity indicator
inside the aluminum can. If the moisture indicator is pink, do
not use the desiccant bag.

Removal and reinstallation of the battery compartment cover are
described in the steps in Section 4.2. To replace the desiccant:

Remove the new desiccant bags from the airtight aluminum can.
Remove the old desiccant bag and install the new one in one of
the corner pockets of the battery compartment (see Figure 4-4).

4.6 Care of the Sensor The plastic coating on the sensor’s transducer disks is important
to the accQpulse’s watertightness. Mishandling, chemicals,
abrasive cleaners, and excessive pressures can damage the trans-
ducers. Inspect them for dents, chipping, peeling, shrinkage,
hairline cracks, and any other damage that may harm water-
tightness or operation. If any damage is found, return the sensor
to the factory. Repairs can only be performed by Teledyne Isco.

CAUTION
Never lay the sensor on a hard or rough surface; always use
foam padding to protect the transducers.

4.7 Cleaning Before storing or shipping the accQpulse, clean it thor-
oughly.

Clean the electronics housing exterior and sensor with mild soap
and  water.  Water less  hand  c leaners  remove  most
petroleum-based fouling. Rinse with water to remove soap
residue. Use care to prevent water from entering the electronics
housing.

Mild chlorine bleach solutions may be used to lessen odors, or to
disinfect the equipment.

Ensure that the unit is completely dry before packaging and
shipment to avoid mold, fungus, and corrosion.

CAUTION
Never use power scrubbers, abrasive cleaners, scouring pads,
high-pressure marine cleaning systems, compressed air, or
brushes stiffer than hand cleaning brushes on the sensor
faces.
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4.8 Troubleshooting 
Procedures

4.8.1 accQpulse 
Unresponsive

If your accQpulse does not respond, check the following items:

1. If the LED is red, ensure that all connectors on the flow 
meter housing have either a dummy plug or the correct 
cable connected, and that no connectors are faulty.

2. If the LED does not come on at all, ensure that power is 
connected to the flow meter. Check the internal batteries 
and/or check that external power is present.

3. If the accQpulse is still unresponsive, contact the factory.

4.8.2 Error Messages If error messages appear when you select Quick Data or Program
and Go, typical causes are a disconnected sensor cable and/or
invalid station file settings. Ensure that the sensor is properly
connected and that Channel Properties, as well as all other
station file settings, are valid, and retry.

4.9 Storage/Shipping 
Preparations CAUTION

Always dry the accQpulse before placing it in storage to pre-
vent corrosion and the growth of mold and fungus. Never store
the accQpulse in damp areas.
Never ship the accQpulse with the batteries installed.

When shipping the accQpulse through Customs, be careful to
position the unit(s) so that identifying labels are clearly visible.
Failure to do so can delay shipment.

For shipping or storage, use the original packaging whenever
possible. If the original packaging materials are no longer
available, contact Teledyne Isco to obtain additional materials.
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Appendix A  Equipment, Parts, and Accessories

A.1 How to Order Parts and equipment can be purchased by contacting Teledyne
Isco’s Customer Service Department. 

Teledyne Isco
Customer Service Dept.
P.O. Box 82531
Lincoln, NE 68501 USA

Phone: (800) 228-4373
(402) 464-0231

FAX: (402) 465-3022

E-mail: IscoInfo@teledyne.com

A.2 General Equipment accQpulse Flow Meter . . . . . . . . . . . . . . . . . . . . . . . . . 62-7400-010

accQpulse Shallow Water Sensor 15 m (49 ft.). . . . . . 60-7404-915

accQpulse Shallow Water Sensor 45 m (147 ft.). . . . . 60-7404-945

accQpulse DeepWater Sensor 15 m (49 ft.). . . . . . . . . 60-7904-915

accQpulse Deep Water Sensor 45 m (147 ft). . . . . . . . 60-7904-945

Flowlink Software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-2540-200

WinADFM Software. . . . . . . . . . . . . . . . . . . . . . . . . . . 60-7004-014

RS232 Communication Cable . . . . . . . . . . . . . . . . . . . 60-7004-057

accQpulse User Manual. . . . . . . . . . . . . . . . . . . . . . . . 60-7404-006

DC Power Cable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60-7004-062

2105/accQpulse ’Y’ Cable . . . . . . . . . . . . . . . . . . . . . . . 69-2004-587

A.3 Optional Interface 
Equipment

accQcomm Interface Module . . . . . . . . . . . . . . . . . . . . 68-7500-010

(converts RS-232 from an accQpulse system to either an industry
standard digital protocol or to a 4-20 mA current loop)

2105 Network Interface Module . . . . . . . . . . . . . . . . . 60-2004-560

(also available with built-in cellular modem; contact factory for
more information)

2105Gi Network Interface Module . . . . . . . . . . . . . . . 68-2000-116

(with 2191 battery and magnetic mount antenna for North
America and Region A countries)
2105Gi Network Interface Module . . . . . . . . . . . . . . . 68-2000-096

(with 2191 battery and magnetic mount antenna for Europe and
Region B countries)

2105Ci Network Interface Module . . . . . . . . . . . . . . . 68-2000-103
(with 2191 battery and magnetic mount antenna)
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A.4 Mounting Accessories Flow Conditioning Platfom, 8"  . . . . . . . . . . . . . . . . . . 60-7404-002

Flow Conditioning Platform, 12". . . . . . . . . . . . . . . . . 60-7404-003

Flow Conditioning Platform, 18". . . . . . . . . . . . . . . . . 60-7404-004

Flow Conditioning Platform, 24". . . . . . . . . . . . . . . . . 60-7404-005

Deep Water Sensor Fairing 3" . . . . . . . . . . . . . . . . . . . 60-7403-040

Deep Water Sensor Debris Kit 3"  . . . . . . . . . . . . . . . . 60-7404-046

Sensor Mounting Plate  . . . . . . . . . . . . . . . . . . . . . . . . 60-7613-003

Suspension Harness Kit  . . . . . . . . . . . . . . . . . . . . . . . 60-7109-002

Spreader Bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60-3004-110

Eyebolt Assembly. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60-7104-007

A.4.1 Sensor Mounting Rings Spring Rings (Each ring includes plastic ties to fasten the cable and a manual)

6" Dia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-3200-007

8" Dia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-3200-008

10" Dia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-3200-009

12" Dia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-3200-010

15" Dia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-3200-011

Scissors Rings (Each scissors ring includes a base section, scissors mechanism,
extensions, plastic ties, and a manual)

16-24" Pipe. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-3000-042

26-38" Pipe. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68-3000-043

A.4.2 Debris Fairing Kits for 
Deep Water Sensors

3

Deep Water Debris Fairing Kit, 3 inch lift . . . . . . . . . 60-7404-046

Deep Water Debris Fairing Kit Spacer, 1 inch lift . . . 60-7004-090

Deep Water Debris Fairing Kit Spacer, 2 inch lift . . . 60-7004-091

Deep Water Debris Fairing Kit Spacer, 4 inch lift . . . 60-7004-092

A.5 Intrinsic Safety 
Equipment and 
Accessories

QBADFM Barrier Box. . . . . . . . . . . . . . . . . . . . . . . 60-7404-021
QBADFM Barrier Box w/ standalone barrier . . . . 60-7404-022
(with factory-installed power barrier and extension cable for
secondary level sensor)
IS Shallow Water accQpulse Sensor 15 m . . . . . . . 60-7404-915
IS Shallow Water accQpulse Sensor 45 m . . . . . . . 60-7404-945
IS Deep Water accQpulse Sensor 15 m  . . . . . . . . . 60-7904-915
IS Deep Water accQpulse Sensor 45 m  . . . . . . . . . 60-7904-945
IS Secondary Level Sensor 15m  . . . . . . . . . . . . . . 60-7404-815
(2.5 to 30 PSI rating is specified at time of order)
IS Secondary Level Sensor 45 m  . . . . . . . . . . . . . . 60-7404-845
(2.5 to 30 PSI rating is specified at time of order)
IS Secondary Level Sensor Custom to 75 m  . . . . . 60-7404-899
(2.5 to 30 PSI rating is specified at time of order)
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Pressure Sensor Field Upgrade Kit . . . . . . . . . . . . 60-7407-001
(includes mounting bracket for standalone barrier, pressure
sensor input cable, scaling resistor, and installation instruc-
tions)
Pressure Sensor Field Upgrade Kit . . . . . . . . . . . . 68-7400-107
(includes kit #60-7407-001 plus MTL700 Series signal barrier
and P75-EXT extension cable; requires separately ordered IS
secondary pressure sensor at specified length)
MTL700 Series Signal Barrier
for Analog 4-20mA Transmitter . . . . . . . . . . . . . . . 109-0220-24
Q75EXT-CTL accQpulse
Sensor Extension Cable  . . . . . . . . . . . . . . . . . . . . . 60-7404-975
(Custom length, maximum 75m combined w/ sensor cable)
P75EXT-CTL Pressure
Sensor Extension Cable  . . . . . . . . . . . . . . . . . . . . . 60-7404-875
(Custom length, maximum 75m)
18VDC Power Supply for IS installations . . . . . . . 60-7404-028
DIN Rail mounting adaptor for IS power supply  . 109-0220-25
DC 24V to 18V Converter power cable
for IS SWADFM. . . . . . . . . . . . . . . . . . . . . . . . . . . . 60-5314-905
Desiccant Bag 16.5g  . . . . . . . . . . . . . . . . . . . . . . . . 099-0002-01
0.2A Fast-Blow Fuse . . . . . . . . . . . . . . . . . . . . . . . . 60-7404-020

A.5.1 QBADFM Barrier Box 
Replacement Parts List
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accQpulse® Velocity Profiler

Appendix B  Material Safety Data Sheets

This appendix provides Material Safety Data Sheets (MSDS) for
the internal desiccant used inside the QBADFM barrier unit.

Specific questions regarding the use and handling of this product
should be directed to the manufacturer listed in the MSDS.
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Warranty

Teledyne Isco One Year Limited Factory Service Warranty* 
This  warranty  exclusively  covers  Teledyne  Isco 

instruments,  providing  a  one-year  limited  warranty 

covering parts and labor. 

Any instrument that fails during the warranty period due to 

faulty parts or workmanship will be repaired at the factory 

at no charge to the customer. Teledyne Isco’s exclusive 

liability is limited to repair or replacement of defective 

instruments. Teledyne Isco is not liable for consequential 

damages. 

Teledyne Isco will pay surface transportation charges both 

ways within the 48 contiguous United States if the 

instrument proves to be defective within 30 days of 

shipment. Throughout the remainder of the warranty period, 

the customer will pay to return the instrument to Teledyne 

Isco, and Teledyne Isco will pay surface transportation to 

return the repaired instrument to the customer. Teledyne 

Isco will not pay air freight or customer’s packing and 

crating charges. This warranty does not cover loss, damage, 

or defects resulting from transportation between the 

customer’s facility and the repair facility. 

The warranty for any instrument is the one in effect on date 

of shipment. The warranty period begins on the shipping 

date, unless Teledyne Isco agrees in writing to a different 

date. 

Excluded from this warranty are normal wear; expendable 

items such as charts, ribbon, lamps, tubing, and glassware; 

fittings and wetted parts of valves; and damage due to 

corrosion, misuse, accident, or lack of proper maintenance. 

This warranty does not cover products not sold under the 

Teledyne Isco trademark or for which any other warranty is 

specifically stated. 

No item may be returned for warranty service without a 

return authorization number issued by Teledyne Isco. 

This warranty is expressly in lieu of all other warranties 

and obligations and Teledyne Isco specifically disclaims 

any warranty of merchantability or fitness for a 

particular purpose. 

The warrantor is Teledyne Isco, 4700 Superior, Lincoln, NE 

68504, U.S.A. 

* This warranty applies to the USA and countries where Teledyne Isco does not have an authorized dealer. 

Customers in countries outside the USA, where Teledyne Isco has an authorized dealer, should contact their 

Teledyne Isco dealer for warranty service. 

Before returning any instrument for repair, please call, fax, or e-mail the Teledyne Isco Service 
Department for instructions. Many problems can often be diagnosed and corrected over the 
phone, or by e-mail, without returning the instrument to the factory. 
Instruments needing factory repair should be packed carefully, and shipped to the attention of 
the service department. Small, non-fragile items can be sent by insured parcel post. PLEASE 
BE SURE TO ENCLOSE A NOTE EXPLAINING THE PROBLEM. 

Shipping Address: Teledyne Isco - Attention Repair Service 
4700 Superior Street 
Lincoln, NE 68504 USA 

Mailing Address: Teledyne Isco 
PO Box 82531 
Lincoln, NE 68501 USA 

Phone: Repair service: (800) 775-2965 (lab instruments) 
(866) 298-6174 (samplers & flow meters) 

Sales & General Information: (800) 228-4373 (USA & Canada) 
Fax: (402) 465-3001 
Email: IscoService@teledyne.com 

February 28, 2012 P/N 60-1002-040 Rev G 
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DECLARATION OF CONFORMITY
   

Application of Council Directive: 2004/108/EC -The EMC Directive 

Manufacturer's Name: Teledyne Isco, Inc. 
Manufacturer's Address: 4700 Superior 

Lincoln, Nebraska 68504-1398  USA 
P.O. Box 82531, Lincoln, NE 68501-2531 

Equipment Type/Environment: 

Phone:          +1 (402) 464-0231 
Facsimile:     +1 (402) 465-3799 

Electrical Equipment Measurement, Control & Laboratory Use - Industrial  

Trade Name/Model No: accQpulse 
Year of Issue: 2016 

Standards to which Conformity is Declared: EN 55011:2009/2011,   Group 1, Class A  
EN 61326-1:2013              EMC Requirements for Electrical Equipment for    

Measurement, Control, and Laboratory Use 

    
Standard Description  Performance Criteria

EN61000-4-2 Electrostatic Discharge  A 

EN61000-4-3 Radiated RF Immunity  A 

EN61000-4-6 Conducted RF on AC lines  A 

EN61000-4-8 Power Frequency Magnetic Field Immunity  A

CISPR11/ 
EN 55011 

RF Emissions  

The undersigned, hereby declares that the design of the equipment specified above conforms to the above Directive(s) and Standards
as of August 26, 2015.

USA Representative

               
                   Edward J. Carter 
                   Director of Engineering 

60-7402-005 
Rev 0 
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accQpulse® Velocity Profiler

Index

A
accessories, A-1
anti-corrosion disk, 4-5
assembly guidelines, 1-8

B
battery, 4-1
battery cover o-ring, 4-4
beam angles, 1-2

C
cables, 1-11
channel geometry, 2-1
cleaning, 4-6
connecting to the accQmin, 2-16
connectors, 1-10, 1-11

D
data

real-time - WinADFM, 2-18
retrieval with Flowlink, 2-33
retrieval with WinADFM, 2-36
viewing with Flowlink, 2-34
viewing with WinADFM, 2-37

desiccant, 4-5
dummy plugs, 1-11

E
error messages, 2-18, 4-7

F
flow conditioning platform, 2-19
flow meter

mounting options, 2-30

I
installation

final precautions, 2-32
flow meter, 2-30
sensor, 2-19, 2-29
suspension mounting, 2-30, 2-31
wall mounting, 2-30

intrinsic safety, 3-1
control drawing, 3-4
equipment and accessories, A-2
QBADFM replacement parts, A-3

L
LED indicators, 1-3, 4-7

M
maintenance, 4-1

anti-corrosion disk, 4-5
battery, 4-1
care and handling, 1-7
cleaning, 4-6
desiccant bag, 4-5
opening the case, 4-3
o-ring, 4-4
QBADFM IS barrier, 3-15
sensor, 4-6
troubleshooting, 4-7

mounting options, 2-30
mounting rings, 2-19

spring rings, 2-20
universal mounting ring, 2-21

O
operation, 1-1

accQmin sensor, 1-1
flow meter, 1-3
secondary depth sensor, 1-4

optional equipment, 1-7
o-ring, 4-4

P
parts, A-1
power, 1-11
programming

channel geometry, 2-1
connecting to the accQmin, 2-1, 2-16
Flowlink, 2-1
WinADFM, 2-9

Q
QBADFM IS barrier, 3-1, 3-3

conduit, 3-4
connections, 3-4
desiccant, 3-15
extension cables, 3-8, 3-10
fuses, 3-16
internal access, 3-8
maintenance, 3-15
reassembly, 3-11
replacement parts list, A-2



accQpulse® Velocity Profiler
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Index-2

wiring table, 3-14

S
safety, 3-1

zone classifications, 3-1
scissors ring, 2-21
secondary depth sensor, 1-4
sensor

beam angles, 1-2
care of, 4-6
dimensions, 1-2
installation, 2-19, 2-29
mounting, 2-19, 2-22

shipping, 4-7
software, 2-1

Flowlink, 2-1
WinADFM, 2-9

specifications, 1-5
storage, 4-7

T
technical specifications, 1-5
troubleshooting, 4-7
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